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1. OBJETIVO 

Establecer las instrucciones para la configuración del entorno de programación de aplicaciones administradas por la 

Oficina de Tecnologías de Información, así como proporcionar a los desarrolladores los pasos necesarios para 

preparar y configurar adecuadamente sus entornos de desarrollo, asegurando que todos los componentes y 

herramientas requeridas estén correctamente instalados y configurados para el desarrollo, pruebas y despliegue de 

aplicaciones en un entorno local. 

 

2. ALCANCE 

El presente documento es de aplicación obligatoria para el equipo de desarrollo de la Oficina de Tecnologías de 

Información de la Sunass. 

 

3. SIGLAS / ACRONIMOS 

OTI :  Oficina de Tecnologías de Información  

STS : Spring Tool Suite 

NPM : Node Package Manager 

JRE :  Java Runtime Enviroment 

JDK : Java Development Kit 

IDE : Entorno de Desarrollo Integrado 

 

4. DEFINICIONES  

 

4.1 Angular: Es un framework de código abierto para el desarrollo de aplicaciones web de una sola página, creado 

y mantenido por Google. Se basa en TypeScript, un superconjunto de JavaScript que añade tipado estático, y 

ofrece herramientas y funcionalidades para crear aplicaciones web modernas y escalables. 

 

4.2 Apache Tomcat: Es un entorno de ejecución de JavaScript de código abierto y multiplataforma que permite 

ejecutar código JavaScript fuera del navegador. Se basa en el motor de ejecución JavaScript V8 de Chrome y 

está diseñado para crear aplicaciones web escalables y en tiempo real. 

 

4.3 Java: Es un lenguaje de programación y una plataforma informática ampliamente utilizada que fue desarrollada 

por Sun Microsystems en 1995 y que actualmente es propiedad de Oracle Corporation. 

 

4.4 NodeJS: Es un entorno de ejecución de JavaScript de código abierto y multiplataforma que permite ejecutar 

código JavaScript fuera del navegador. Se basa en el motor de ejecución JavaScript V8 de Chrome y está 

diseñado para crear aplicaciones web escalables y en tiempo real. 

 

4.5 Spring Framework: Es un marco de trabajo de código abierto para el desarrollo de aplicaciones Java. Es uno 

de los marcos de trabajo más populares para Java y se utiliza para crear una amplia gama de aplicaciones, 

desde aplicaciones web y móviles hasta software empresarial 

 

4.6. Spring Tool Suite (STS): Es un entorno de desarrollo integrado (IDE) de código abierto basado en Eclipse, 

específicamente diseñado para el desarrollo de aplicaciones Java con el framework Spring. Está desarrollado 

por la comunidad SpringSource y cuenta con el respaldo oficial de VMware. 

 

4.7. Visual Studio Code: Es un editor de código fuente gratuito, de código abierto y multiplataforma desarrollado por 

Microsoft. Es una herramienta popular entre programadores y desarrolladores de software para escribir y probar 

código. Soporta múltiples lenguajes de programación: VSCode admite una amplia gama de lenguajes de 

programación, como JavaScript, Python, C++, C#, HTML, CSS y muchos más. 
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5. DESARROLLO DEL INSTRUCTIVO 

 

5.1 CONFIGURACIÓN DEL ENTORNO PARA JAVA:  

 

5.1.1 Descargar e instalar Oracle JDK 

 

a) Descargar el instalador del JDK más reciente para Windows desde la página oficial de Oracle: Oracle 

JDK: 

 

 
 

b) Seguir las instrucciones que se muestran en la pantalla para completar la instalación: 

 

 
 

c) Una vez culminada la instalación, hacer clic en “Close”: 

 

https://www.oracle.com/java/technologies/javase-downloads.html
https://www.oracle.com/java/technologies/javase-downloads.html
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5.1.2 Configurar las variables de entorno para Java 

 

a) Hacer clic derecho en "Este equipo" y seleccionar "Propiedades" en el menú contextual: 

 

 
 

b) En la ventana “sistema”, seleccionar la opción "Configuración avanzada del sistema". 

 

 
 

c) En la ventana “Propiedades del sistema”, hacer clic en "Variables de entorno…": 
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d) En la sección de “Variables del sistema”, hacer clic en "Nueva...". 

 

 
 

e) Obtener la ruta de instalación del Oracle JDK (por ejemplo, C:\Program Files\Java\jdk-11). 
 

 
 

f) Luego, colocar el nombre de la variable como JAVA_HOME y registrar la ruta obtenida en el paso 

anterior en la ventana “Nueva variable del sistema” y hacer clic en Aceptar. 
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5.1.3 Editar la variable Path en el sistema 

 

a) En la sección de “Variables del sistema”, seleccionar la variable Path y hacer clic en "Editar". En la 

nueva ventana seleccionar la ruta : %JAVA_HOME%\bin y hacer clic en el botón “Editar”: 

 

 
 

b) Finalmente, hacer clic en el botón “Aceptar”. 

 

5.1.4 Comprobar la instalación de Java 

 

a)  Abrir la línea de comandos presionando el atajo “Win + R”. En la ventana “Ejecutar” escribir “CMD” 

o “Power Shell” y luego hacer clic en “Enter”: 

1 

2 

3 

4 
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b) En la ventana del CMD, escribir “java -version” y presionar “Enter”. Con ello se mostrará la versión 

de Java que se encuentra instalada: 

 

 
 

5.2 INSTALACIÓN DEL IDE SPRING TOOL SUITE (STS) 

 

5.2.1 Descargar el IDE 

 

a) Ingresar a la página oficial de Spring Tool Suite desde este enlace:  Spring Tool Suite. Luego, hacer 

clic en la opción que corresponda al sistema operativo que se está empleando. En la siguiente imagen 

se emplea Windows: 

 

 
 

b) Ubicar el archivo ejecutable que por defecto se guardará en la carpeta ”Descargas”: 

 

https://spring.io/tools
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5.2.2 Instalar el IDE STS 

 

a) Crear una nueva carpeta con el nombre “STS” en el disco C: 

 

 
 

b) Copiar el archivo de la carpeta “Descargas” y pegarlo en la carpeta “STS” creada en el disco C, hacer 

clic derecho y seleccionar “extraer aquí” del menú contextual:  

 

 
 

Al descomprimir el ejecutable, se mostrará 4 archivos, luego descomprimir el archivo “contents” 
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c) Después de haber descomprimido la carpeta contents, abrir la carpeta “sts-4.22.1.RELEASE“ y 

observará el archivo ejecutable del STS  con nombre “SpringToolSuite4”: 

 

 
 

d) Crear una nueva carpeta para el espacio de trabajo del IDE instalado. De preferencia crearlo en otra 

unidad como el disco D. El nombre de la carpeta podría ser de acuerdo a su proyecto en curso, por 

ejemplo:  Workspace-Proyecto XYZ:  

 

 
 

En esta carpeta se alojarán todas las aplicaciones desarrolladas en el lenguaje Java. 

 

e) Luego, hacer doble clic en el ejecutable “SpringToolSuite4” (indicado en el paso 3). En la nueva 

ventana hacer clic en “Browse” para buscar el directorio del proyecto en la unidad correspondiente, 

luego marcar la casilla de verificación y hacer clic en “Launch”: 
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5.3 INSTALACIÓN Y CONFIGUIRACIÓN DE MAVEN 

 

5.3.1 Descargar Maven 

Descargar la última versión del archivo Binary zip desde la página oficial de Apache Maven Apache 

Maven. Si se desea descargar versiones anteriores a la actual entrar a este enlace. 

 

 
 

5.3.2 Instalar Maven 

Extraer el archivo ZIP descargado (por defecto está ubicado en la carpeta “Descargas” de Windows) en 

el disco C: 

 

 
 

5.3.3 Configurar variables de entorno para Maven 

 

a) De forma similar como se realizó la configuración para JAVA_HOME, ingresar a la configuración de 

“Variables de Entorno” para añadir una nueva variable del sistema para Maven.  

2 

1 

https://maven.apache.org/download.cgi
https://maven.apache.org/download.cgi
https://archive.apache.org/dist/maven/maven-3/
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b)  Obtener la ruta de instalación de Maven (por ejemplo, C:\apache-maven-3.9.6). 

 

 
 

c) Dirigirse a la “configuración avanzada del Sistema”, en la ventana de “Propiedades del sistema”, 

hacer clic en “variables de entorno …” y en la sección de “Variables del sistema” hacer clic en 

“Nueva…”. 

 

 
 

d) Luego, editar la variable Path y en la en la ventana “Editar variable de entorno” hacer clic en “Editar”, 

añadir una nueva variable con el nombre MAVEN_HOME o M2_HOME  y valor de %M2_HOME%\bin 

y hacer clic en el botón “Aceptar”: 
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5.3.4 Comprobar la instalación de Maven 

 

a)  Presionar el atajo “Windows +R”, aparecerá la ventana “Ejecutar”, lo cual debe escribir CMD, sin 

importar sea mayúscula o minúscula, luego hacer clic en Aceptar. 

 

 
 

b) En la ventana del Símbolo del Sistema, se debe comprobar la versión de Maven, escribiendo 

mediante el comando: mvn -version y luego presionar Enter. Con ello se mostrará la versión de 

Maven que se encuentra instalada. 
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5.4 CREACIÓN DE UN NUEVO PROYECTO JAVA EN STS 

 

5.4.1 Abrir el Spring Tool Suite. Al Ejecutar el STS seleccionar el directorio correspondiente para el workspace. 

Luego el asistente indicará que primero debe elegir una nueva carpeta o dejar por defecto la ruta que el 

asistente recomienda para crearlo. 

 

 
 

No olvidar marcar el checkbox “Use this as the default and do not ask again” de la imagen anterior. 

 

5.4.2 En la nueva ventana seleccionar la opción “File” del menú superior del IDE:  

 

 
 

5.4.3 Elegir el tipo de proyecto Java que desee desarrollar y seguir cualquiera de estas rutas:  

 

- File > New > Spring Starter Project (para proyectos Spring Boot) o 

- File > New > Other > Maven Project (para proyectos Java con Maven) o  

- File > New > Other > Java Project (para Java Standar Edition), según se observa en la imagen 

inferior: 
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5.4.4 Para proyectos tipo Spring Boot, llenar los datos que corresponda al contexto del proyecto según se 

muestra en la siguiente imagen y hacer clic “Next”: 
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5.4.5 Elegir las dependencias necesarias para su aplicación y finalmente hacer clic en “Finish”: 

 

 
 

5.5 INSTALACIÓN Y CONFIGURACIÓN DE UN SERVIDOR DE APLICACIONES: APACHE TOMCAT. 

Solo se realiza si se trata de un proyecto que no usa Spring Boot. 

 

5.5.1 Descargar e instalar Tomcat: 

 

a) Descargar la versión binaria ZIP más reciente desde la página oficial de Apache Tomcat 

 

https://tomcat.apache.org/download-90.cgi
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b) Extraer el archivo ZIP descargado en el disco C, en esta ruta : C:\apache-tomcat-9.0.79 

 

 
 

5.5.2 Añadir el servidor Apache Tomcat al IDE STS: 

 

a) Al abrir el IDE, verificar si tiene la perspectiva Java EE, en caso no lo tenga, ir a: Help -> Eclipse 

Marketplace: 

 



 

GESTIÓN DE TECNOLOGÍAS DE LA INFORMACIÓN 
OPERACIÓN DE LAS TECNOLOGÍAS DE LA 

INFORMACIÓN 

INSTRUCTIVO 
CONFIGURACIÓN DE ENTORNOS DE 

DESARROLLO PARA DIFERENTES 
LENGUAJES 

Versión: 001 
Fecha de vigencia: 08/04/2025 

Código: GTI-OTI-IN011 Página 19 de 29 

 

 

ESTE DOCUMENTO IMPRESO ES UNA COPIA NO CONTROLADA 

Para ver el documento controlado ingrese al portal del SIG de la Sunass 

Uso Interno 

 
 

b) Luego, buscar el plugin “Eclipse Enterprise Java and Web Developer Tools”: 

 

 
 

c) Seguir las instrucciones básicas, aceptar los términos y condiciones. Después según lo indicado por 

el IDE, debe aceptar el reinicio del programa para que se refleje los cambios. 

 

d) Culminada la instalación, en la siguiente ventana debe elegir la perspectiva Java  EE: 
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e) En el IDE STS, ir a la vista “Servers”: 

 

 
 

f) Hacer clic derecho en “Servers” y en la lista seleccionar New > Server. Luego seleccionar Apache > 

Tomcat v9.0 Server (o la versión que se haya descargado) y hacer clic en “Next”: 

 

 
 

g) Seleccionar la carpeta donde este instalado el Tomcat y elegir la versión del JDK o JRE por defecto 

del IDE: 
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5.5.3 Añadir el proyecto al servidor: 

 

a) En la vista “Servers”, hacer clic derecho en el servidor Tomcat y elegir la opción “Add and Remove”. 

 

b) En esta nueva ventana añadir el proyecto al servidor, dando clic en “ADD>” y luego hacer clic en  

“Finish”. 

 

 
 

5.5.4 Iniciar y detener el servidor: 

 

a) Para iniciar el servidor, hacer clic derecho en el servidor Tomcat y en la vista “Servers” seleccionar 

la opción “Start”. 
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b) Luego para detener el servidor, hacer clic derecho en el servidor Tomcat y en la vista “Servers” 

seleccionar la opción “Stop”. 

 

5.5.5 Comprobar el despliegue del proyect 

 

Abrir el navegador web de preferencia. Luego, probar la aplicación con esta URL http://localhost:8080/  (o 

el puerto que se encuentre configurado) y concatenado con su contextPath para comprobar que el 

proyecto se ha desplegado correctamente. 

 

5.6 INSTALACIÓN DE HERRAMIENTAS PARA ANGULAR 

 

5.6.1 Descargar e instalar Node.js: 

Visitar la página oficial de Node.js. Luego, descargar el instalador LTS (Long Term Support) para Windows 

e instalarlo, seguir las instrucciones de la instalación paso a paso como se menciona, por ejemplo, en 

este enlace:  https://kinsta.com/es/blog/como-instalar-node-js/ 

 

5.6.2 Comprobar la instalación de Node.js y npm: 

 

a) Presionar el atajo “Windows +R”. En la ventana “Ejecutar” y escribir “CMD”: 

 

 
 

http://localhost:8080/
https://kinsta.com/es/blog/como-instalar-node-js/
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b) En la terminal de window escribir node -v y npm -v para comprobar que el Node.js y npm están 

instalados correctamente: 

 

 
 

5.6.3 Descargar el NVM(opcional):  

 

a) En caso se necesite otras versiones de NodeJS, se debe instalar el gestor NVM(node versión 

manager), de acuerdo a los pasos señalados en este enlace: https://learn.microsoft.com/es-

es/windows/dev-environment/javascript/nodejs-on-windows#install-nvm-windows-nodejs-and-npm. 

La descarga se realiza siguiendo las instrucciones desde el github: 

https://github.com/coreybutler/nvm-windows/releases 

 

 
 

b) Una vez finalizada la descarga, abrir el instalador y seleccionar “Sí”, a la pregunta “desea permitir 

que la aplicación realice cambios en su dispositivo o no”. 

 

c) En la ventana del acuerdo de licencia, seleccionar “Acepto el acuerdo” y hacer clic en “Siguiente”: 

 

 
 

https://learn.microsoft.com/es-es/windows/dev-environment/javascript/nodejs-on-windows#install-nvm-windows-nodejs-and-npm
https://learn.microsoft.com/es-es/windows/dev-environment/javascript/nodejs-on-windows#install-nvm-windows-nodejs-and-npm
https://github.com/coreybutler/nvm-windows/releases
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d) Luego seleccionar la ubicación de destino, especificando dónde desea que se instale nvm para 

Windows y hacer clic en “siguiente”: 

 

 
 

e) Una vez que todo esté configurado, se procede a instalar el nvm. Para ello, en la siguiente ventana, 

hacer clic en “Instalar”:  

 

 
 

f) Una vez finalizado el proceso de instalación, hacer clic en  “Finalizar”: 

 

 
 



 

GESTIÓN DE TECNOLOGÍAS DE LA INFORMACIÓN 
OPERACIÓN DE LAS TECNOLOGÍAS DE LA 

INFORMACIÓN 

INSTRUCTIVO 
CONFIGURACIÓN DE ENTORNOS DE 

DESARROLLO PARA DIFERENTES 
LENGUAJES 

Versión: 001 
Fecha de vigencia: 08/04/2025 

Código: GTI-OTI-IN011 Página 25 de 29 

 

 

ESTE DOCUMENTO IMPRESO ES UNA COPIA NO CONTROLADA 

Para ver el documento controlado ingrese al portal del SIG de la Sunass 

Uso Interno 

g) Para confirmar que la instalación se ha completado, abrir “Windows PowerShell” o el “Simbolo del 

Sistema” o “GitBash”, en cualquiera puede ejecutar el comando: nvm -v 

 

 
 

5.7 INSTALACIÓN DEL ANGULAR CLI 

 

5.7.1 Instalar el angular CLI:   

En la terminal de windows en Power Shell, escribir npm install -g @angular/cli y presionar Enter. Si se 

desea instalar otra versión menor de angular, puede aplicar el comando: npm install -g @angular/cli@12 

 

 
 

5.7.2 Comprobar la instalación de angular CLI 

Aquí puede abrir una terminal del GIT(Git Bash) u otra terminal de su preferencia, y luego escribir el 

comando: ng version , para comprobar la versión de Angular CLI instalada: 
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5.8 INSTALACIÓN DE  VISUAL STUDIO CODE (VS CODE) 

Se debe instalar en caso de no usar WebStorm o Sublime Text 

 

5.8.1 Instalar Visual Studio Code: 

 

a) Ingresar a la página oficial de Visual Studio Code: VS Code. Luego, descargar el instalador para 

Windows: 

 

 
 

b) Para los siguientes pasos de la instalación debe guiarse de lo señalado en este enlace: 

https://support.academicsoftware.eu/hc/es/articles/360006916138-C%C3%B3mo-instalar-Microsoft-

Visual-Studio-Code 

 

5.8.2 Configurar Extensiones en VS Code 

 

a) Abrir Visual Studio Code: 

 

 
 

b) Instalar las extensiones recomendadas: 

https://code.visualstudio.com/
https://support.academicsoftware.eu/hc/es/articles/360006916138-C%C3%B3mo-instalar-Microsoft-Visual-Studio-Code
https://support.academicsoftware.eu/hc/es/articles/360006916138-C%C3%B3mo-instalar-Microsoft-Visual-Studio-Code
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• Hacer clic en el ícono de extensiones en la barra lateral izquierda. 

• Buscar e instalar las siguientes extensiones: 

- Angular Language Service 

- ESLint (si deseas linting para tu código) 

- Prettier (para formateo de código) 

 

5.9 CREACIÓN DE UN NUEVO PROYECTO ANGULAR 

 

5.9.1 Crear la carpeta de trabajo en el disco D, por ejemplo: Worskpace Angular. 

 

5.9.2 En la carpeta creada, abrir una terminal (por ejemplo, el git bash) y escribir “ng new my-angular-app” y 

seguir las instrucciones para configurar el nuevo proyecto angular. 

 

 
 

5.9.3 Escribir “ng new my-angular-app” y luego presionar Enter,asi see creará el nuevo proyecto angular. 
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5.9.4 Luego, en Visual Studio Code, en el menú superior ir a  : File -> Open Folder. 

 

 
 

5.9.5 Dirigirse al directorio del proyecto “my-angular-app” u otro proyecto existente, y finalmente hacer clic en 

seleccionar carpeta 

 

 
 

5.10 EJECUCIÓN DE LA APLICACIÓN ANGULAR 

 

5.10.1 Hacer clic derecho dentro del proyecto Angular y en el menú contextual hacer clic en “Abrir con Code”: 
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Luego escribir “ng serve” para ejecutar la aplicación: 

 

 
 

5.10.2 Finalmente, abrir el navegador de preferencia (Chrome, Mozilla Firefox, Edge,etc.) e ingresar a la 

siguiente ruta: http://localhost:4200 (puerto por defecto), con ello se podrá navegar en la aplicación web. 

 

http://localhost:4200(puerto

